RZ/T2, RZ/N2

Getting Started with Flexible Software Package

Introduction
This manual describes how to use the Renesas Flexible Software Package (FSP) for writing applications for the RZ/T2, RZ/N2 microprocessor series.

Target Device
RZ/T2M, RZ/T2L, RZ/N2L

About the video contents
We provide videos on how to install the development tools that will enable you to start developing applications for the RZ/T and RZ/N series of MPUs. Access the following links:

RZ/T RZ/N FSP Quick Start Guide - FSP Installation and Generating Your First Project for e2 studio
RZ/T RZ/N FSP Quick Start Guide - FSP Installation & Generating Your First Project for EWARM & FSP SC
Contents

1. Introduction ........................................................................................................................................5
   1.1 Overview .......................................................................................................................................5
   1.2 Introduction to FSP .........................................................................................................................5
       1.2.1 Purpose ......................................................................................................................................5
       1.2.2 e² studio IDE ............................................................................................................................5
       1.2.3 FSP Smart Configurator ..........................................................................................................5
       1.2.4 FSP Documentation .................................................................................................................5
   1.3 Related Documentation Files .........................................................................................................6
       1.3.1 Renesas Starter Kit+ User’s Manual .........................................................................................6
       1.3.2 FSP Documentation ................................................................................................................6
   1.4 Starting Development Introduction ..............................................................................................7

2. Set up Renesas Starter kit+ for RZ/T2, RZ/N2 CPU Board .................................................................8
   2.1 Obtaining an Renesas Starter Kit+ .................................................................................................8
   2.2 System Configuration ....................................................................................................................8
   2.3 Supported Emulator .......................................................................................................................9
       2.3.1 SEGGER J-Link .........................................................................................................................9
       2.3.2 IAR I-Jet ..................................................................................................................................9
   2.4 RSK+RZT2M Board Setup ............................................................................................................10
       2.4.1 Boot Mode ...............................................................................................................................10
       2.4.2 Debugger Connection .............................................................................................................11
       2.4.3 Power Supply ..........................................................................................................................12
   2.5 RSK+RZT2L Board Setup .............................................................................................................13
       2.5.1 Boot Mode ...............................................................................................................................13
       2.5.2 Debugger Connection .............................................................................................................14
       2.5.3 Power Supply ..........................................................................................................................15
   2.6 RSK+RZN2L Board Setup .............................................................................................................16
       2.6.1 Boot Mode ...............................................................................................................................16
       2.6.2 Debugger Connection .............................................................................................................17
       2.6.3 Power Supply ..........................................................................................................................18

3. e² studio Setup .....................................................................................................................................19
   3.1 What is e² studio? ...........................................................................................................................19
   3.2 e² studio Prerequisites ...................................................................................................................19
       3.2.1 Windows PC Requirements ..................................................................................................19
       3.2.2 Installing e² studio, Platform Installer and FSP Package ......................................................19
       3.2.3 Choosing a Toolchain ............................................................................................................19
       3.2.4 Licensing ...............................................................................................................................19

4. Tutorial: Your First RZ/T2, RZ/N2 MPU Project – Blinky .................................................................20
4.1 Tutorial Blinky ................................................................. 20
4.2 What Does Blinky Do? .................................................... 20
4.3 Create a New Project for Blinky ....................................... 21
4.3.1 Details about the Blinky Configuration ......................... 26
4.3.2 Configuring the Blinky Clocks .................................... 26
4.3.3 Configuring the Blinky Pins ........................................ 26
4.3.4 Configuring the Parameters for Blinky Components ....... 26
4.3.5 Where is main()? ...................................................... 26
4.3.6 Blinky Example Code ................................................ 26
4.4 Build the Blinky Project .................................................. 27
4.5 Debug the Blinky Project ................................................ 28
4.5.1 Debug Prerequisites .................................................. 28
4.5.2 Debug Steps ......................................................... 28
4.5.3 Details about the Debug Process .................................. 31
4.6 Run the Blinky Project .................................................... 32

5. FSP Smart Configurator User Guide ..................................... 33
5.1 What is FSP Smart Configurator? .................................... 33
5.2 Tutorial Blinky .................................................................. 33
5.3 Using Smart Configurator with IAR EWARM ..................... 33
5.3.1 Prerequisites .......................................................... 33
5.3.2 Create a New Project ................................................ 34
5.3.2.1 NOTE: Configure IAR EWARM Project [Only RZ/N2L] 40
5.3.3 Build the Project ....................................................... 43
5.3.4 Download & Debug the Project .................................. 44
5.4 Re-configuring Project with FSP SC ................................ 48
5.4.1 Launch FSP Smart Configurator from IAR EWARM .... 48
5.4.2 Launch from the Command Prompt ............................. 48

6. FSP Configuration Users Guide .......................................... 49
6.1 What is a Project? ........................................................... 49
6.2 Create a Project ............................................................. 51
6.2.1 Creating a New Project .............................................. 51
6.2.2 Selecting a Board and Toolchain ................................. 53
6.2.3 Selecting a Project Template ...................................... 54
6.3 Configuring a Project ...................................................... 57
6.3.1 Summary Tab .......................................................... 57
6.3.2 Configuring the BSP .................................................. 58
6.3.3 Configuring Clocks .................................................... 59
6.3.4 Configuring Pins ........................................................ 60
6.4 Configuring Interrupts from the Stacks Tab ....................... 63
6.4.1 Creating Interrupts from the Interrupts Tab .................... 64
1. Introduction

1.1 Overview
This application note describes how to use the Renesas Flexible Software Package (FSP) running on the Cortex®-R52 (hereinafter referred to as CR52) incorporated on RZ/T2 and RZ/N2.

1.2 Introduction to FSP

1.2.1 Purpose
The Renesas Flexible Software Package (FSP) is an optimized software package designed to provide easy to use, scalable, high quality software for embedded system design. The primary goal is to provide lightweight, efficient the hardware abstraction layer (HAL) drivers and the board support package (BSP) that meet common use cases in embedded systems.

1.2.2 e² studio IDE
FSP provides a host of efficiency enhancing tools for developing projects targeting the Renesas RZ/T2, RZ/N2 series of MPU devices. The e² studio IDE provides a familiar development cockpit from which the key steps of project creation, module selection and configuration, code development, code generation, and debugging are all managed.

1.2.3 FSP Smart Configurator
The Renesas FSP Smart Configurator (FSP SC) is a desktop application designed to configure device hardware such as clock set up and pin assignment as well as initialization of FSP software components when using a 3rd-party IDE and toolchain.
For creating RZ/T2, RZ/N2 project, the FSP SC can currently be used with
• IAR Systems Embedded Workbench for Arm (IAR EWARM) with IAR toolchain for Arm

1.2.4 FSP Documentation
The related file “FSP Documentation” contains HTML documentations describing the features, APIs and usage notes regarding the BSP and HAL drivers implemented as FSP modules and interfaces. After clicking the “index.html” in “FSP Documentation” to open the introduction page on your html browser, the reference documents for utilizing each FSP module and interface can be read from “API Reference” menu.
1.3 Related Documentation Files

The related documentation files are shown in the following.

1.3.1 Renesas Starter Kit+ User’s Manual

This Getting Started Guide refers to the following “Evaluation Board Kit User’s Manual”.

- RZ/T2M Group Renesas Starter Kit+ for RZ/T2M User’s Manual
  ➢ Document No. R20UT4939
- RZ/T2L Group Renesas Starter Kit+ for RZ/T2L User’s Manual
  ➢ Document No. R20UT5164
- RZ/N2L Group Renesas Starter Kit+ for RZ/N2L User’s Manual
  ➢ Document No. R20UT4984

These documents can be found on Renesas web site by inputting their Document No. into search box.
- URL: https://www.renesas.com/

![Figure 1: Search Box in Renesas Web Page](image)

1.3.2 FSP Documentation

This Getting Started Guide refers to the following “FSP Documentation”.
These documents are available in Renesas Git repository in GitHub.

- RZ/T2 Flexible Software Package Documentation
  ➢ URL: https://github.com/renesas/rzt-fsp/releases
  ➢ File name: fsp_documentation_vx.x.x.zip
- RZ/N2 Flexible Software Package Documentation
  ➢ URL: https://github.com/renesas/rzn-fsp/releases
  ➢ File name: fsp_documentation_vx.x.x.zip

Note: The “vx.x.x” is the FSP version number such as “v1.0.0”.

Note for RZ/N2L:
The RZ/N2L FSP documentation can also be viewed in a web browser by accessing the following link, but it is RZ/N2L FSP v1.0.0 content.
- URL: https://renesas.github.io/rzn-fsp/
The latest version of the document should be obtained as a zip file as described above.
1.4 Starting Development Introduction

FSP application project can be created by e² studio or FSP SC (for IAR EWARM), and this Getting Started includes tutorial for both tools; the chapters you should read changes.

e² studio users should read the following chapters:
- Chapter 2 “Set up Renesas Starter kit+ for RZ/T2, RZ/N2 CPU Board”
- Chapter 3 “e² studio Setup”
- Chapter 4 “Tutorial: Your First RZ/T2, RZ/N2 MPU Project – Blinky”
- Chapter 6 “FSP Configuration Users Guide”

FSP SC users (for IAR EWARM users) should read the following chapters:
- Chapter 2 ”Set up Renesas Starter kit+ for RZ/T2, RZ/N2 CPU Board”
- Chapter 5 “FSP Smart Configurator User Guide”
- Chapter 6 “FSP Configuration Users Guide”

The summary of each chapter is shown below.
- Chapter 2 ”Set up Renesas Starter kit+ for RZ/T2, RZ/N2 CPU Board”
  - Explains how to setup Renesas Starter kit+ for RZ/T2, RZ/N2 CPU Board to proceed the tutorials in Chapter 4 and 5.
- Chapter 3 “e² studio Setup”
  - Explains the setup of e² studio for utilizing FSP.
- Chapter 4 “Tutorial: Your First RZ/T2, RZ/N2 MPU Project – Blinky”
  - Explains the tutorial with minimal steps to create, run, and debug a FSP project by using e² studio.
- Chapter 5 “FSP Smart Configurator User Guide”
  - Explains the tutorial with minimal steps to create an FSP project as IAR EWARM project by using the FSP Smart Configurator and to run and debug the created IAR EWARM project.
- Chapter 6 “FSP Configuration Users Guide”
  - Explains how to create and configure an FSP project in detail.
  - The explanation is described based on e² studio, but most of the explanations are applied to the FSP smart configurator.
2. **Set up Renesas Starter kit+ for RZ/T2, RZ/N2 CPU Board**

2.1 **Obtaining an Renesas Starter Kit+**
To develop applications with RZ/T2 FSP and RZ/N2 FSP, start with Renesas Starter Kit+ (RSK).

The Renesas Starter Kit+ for RZ/T2 and RZ/N2 CPU Board (RSK+RZT2M, RSK+RZ/T2L, and RSK+RZN2L) are designed to seamlessly integrate with the e² studio.

Ordering information, User Manuals, and other related documents for RSK boards are available. Please contact Renesas to get them.

2.2 **System Configuration**
Below is an example of a typical system configuration of RSK board.

![Diagram of System Configuration Example – with RSK Board](image)

*Figure 2: System Configuration Example – with RSK Board*

For the details, please refer to the related document “Renesas Starter Kit+ User’s Manual”.

2.3 Supported Emulator

2.3.1 SEGGER J-Link
SEGGER J-Link can be used on Renesas eStudio only for debugging on RZ/T2 and RZ/N2 devices. Renesas eStudio supports the following emulators:

- J-Link EDU V11 and later
- J-Link BASE V11 and later
- J-Link PLUS V11 and later
- J-Link WiFi V1 and later
- J-Link ULTRA+ V5 and later
- J-Link PRO V5 and later
- J-Link OB-S124 V1.00

Renesas has tested debugging RZ/T2 and RZ/N2 devices with J-Link BASE V11 and J-Link OB-S124. For the details on SEGGER J-Link, please see SEGGER website.

Debugging FSP Project was verified with the following software environment.

<table>
<thead>
<tr>
<th>Device</th>
<th>FSP version</th>
<th>eStudio version</th>
<th>J-Link Software version</th>
</tr>
</thead>
<tbody>
<tr>
<td>RZ/T2M, RZ/T2L</td>
<td>RZ/T2 FSP v1.3.0</td>
<td>2023-07</td>
<td>V7.88k</td>
</tr>
<tr>
<td>RZ/N2L</td>
<td>RZ/N2L FSP v1.3.0</td>
<td>2023-07</td>
<td>V7.88k</td>
</tr>
</tbody>
</table>

2.3.2 IAR I-Jet
IAR I-jet can be used on IAR EWARM only for debugging on RZ/T2 and RZ/N2 devices. For the details on IAR I-jet, please see IAR Systems website.
2.4 RSK+RZT2M Board Setup

2.4.1 Boot Mode

The operation mode settings for the RSK+RZT2M board are as follows. This section shows the settings for running on RAM without external flash memory. For settings to run in other boot modes, please refer to the manual of the RSK boards listed in chapter 1.3.1.

Figure 3: Switch Position of Operation Mode Settings for RSK+RZT2M

<table>
<thead>
<tr>
<th>Switch</th>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SW4.1</td>
<td>ON</td>
<td>16-bit bus boot mode (NOR Flash)</td>
</tr>
<tr>
<td>SW4.2</td>
<td>OFF</td>
<td></td>
</tr>
<tr>
<td>SW4.3</td>
<td>ON</td>
<td></td>
</tr>
<tr>
<td>SW4.4</td>
<td>ON</td>
<td>JTAG Authentication by Hash is disabled.</td>
</tr>
<tr>
<td>SW4.5</td>
<td>ON</td>
<td>ATCM 0 wait</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Valid for CPU operating frequency equal to or less than 400MHz.</td>
</tr>
</tbody>
</table>
2.4.2 Debugger Connection

If you use JTAG connection with I-Jet or J-Link,

1) Short the jumper pin (J9) for switching the debug connection so that RSK+RZT2M board can use the emulator connected to JTAG connector (J20).

2) Connect the emulator (J-Link or I-jet) to a free USB port on your computer.

3) Connect the IAR I-Jet to the RSK+RZT2M board ensuring that it is plugged in to the header “J20”.

![Figure 4: Jumper Position of JTAG connection for RSK+RZT2M](image)

If you use J-Link OB on RSK+RZT2M board,

1) Open the jumper pin (J9) for switching the debug connection so that RSK+RZT2M can use J-Link OB on the board.

2) Connect the micro-USB type-B to J-Link OB USB connector (J10), and then the LED4 is lighted.

![Figure 5: J-Link OB Connection Settings for RSK+RZT2M](image)
2.4.3 Power Supply

Power is supplied using a USB cable (Type-C) or an AC/DC adapter.

- When using a USB cable (Type-C), connect it to the USB connector “CN5” of the RSK+RZT2M board.
- When connecting the AC/DC adapter, connect it to the USB connector “CN6” of the RSK+RZT2M board.

Figure 6: How to Power Supply for RSK+RZT2M
2.5 RSK+RZT2L Board Setup

2.5.1 Boot Mode

The operation mode settings for the RSK+RZT2L board are as follows. This section shows the settings for running on RAM without external flash memory. For settings to run in other boot modes, please refer to the manual of the RSK boards listed in chapter 1.3.1.

![RSK+RZT2L Board Setup](image)

Figure 7: Switch Position of Operation Mode Settings for RSK+RZT2L

<table>
<thead>
<tr>
<th>Switch</th>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SW4.1</td>
<td>ON</td>
<td>xSPI0 boot mode (x1 boot serial flash)</td>
</tr>
<tr>
<td>SW4.2</td>
<td>ON</td>
<td></td>
</tr>
<tr>
<td>SW4.3</td>
<td>ON</td>
<td></td>
</tr>
<tr>
<td>SW4.4</td>
<td>ON</td>
<td>ATCM wait cycle = 0 wait</td>
</tr>
<tr>
<td>SW4.5</td>
<td>ON</td>
<td>JTAG mode = Normal mode</td>
</tr>
</tbody>
</table>
2.5.2 Debugger Connection

If you use JTAG connection with I-Jet or J-Link,

1) Short the jumper pin (J9) for switching the debug connection so that RSK+RZT2L board can use the emulator connected to JTAG connector (J20).

2) Connect the emulator (J-Link or I-jet) to a free USB port on your computer.

3) Connect the IAR I-Jet to the RSK+RZT2L board ensuring that it is plugged in to the header “J20”.

Figure 8: Jumper Position of JTAG connection for RSK+RZT2L

If you use J-Link OB on RSK+RZT2L board,

1) Open the jumper pin (J9) for switching the debug connection so that RSK+RZT2L can use J-Link OB on the board.

2) Connect the micro-USB type-B to J-Link OB USB connector (J10), and then the LED6 is lighted.

Figure 9: J-Link OB Connection Settings for RSK+RZT2L
2.5.3 Power Supply

Power is supplied using a USB cable (Type-C) or an AC / DC adapter.

- When using a USB cable (Type-C), connect it to the USB connector “CN5” of the RSK+RZT2L board.
- When connecting the AC / DC adapter, connect it to the USB connector “CN6” of the RSK+RZT2L board.
- After connecting to the power (CN5 or CN6), turn on the POWER_SW slide switch to start power supply.

The figure below is when a USB cable (Type-C) is used.

Figure 10: How to Power Supply for RSK+RZT2L
2.6 RSK+RZN2L Board Setup

2.6.1 Boot Mode

The operation mode settings for the RSK+RZN2L board are as follows. This section shows the settings for running on RAM without external flash memory. For settings to run in other boot modes, please refer to the manual of the RSK boards listed in chapter 1.3.1.

![Figure 11: Switch Position of Operation Mode Settings for RSK+RZN2L](image)

**Table 4 Operation Mode Switch Settings for RSK+RZN2L**

<table>
<thead>
<tr>
<th>Switch</th>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SW4.1</td>
<td>ON</td>
<td>16-bit bus boot mode (NOR flash)</td>
</tr>
<tr>
<td>SW4.2</td>
<td>OFF</td>
<td></td>
</tr>
<tr>
<td>SW4.3</td>
<td>ON</td>
<td></td>
</tr>
<tr>
<td>SW4.4</td>
<td>ON</td>
<td>JTAG Authentication by Hash is disabled.</td>
</tr>
</tbody>
</table>
2.6.2 Debugger Connection

If you use JTAG connection with I-Jet or J-Link,
1) Short the jumper pin (J9) for switching the debug connection so that RSK+RZN2L board can use the emulator connected to JTAG connector (J20).
2) Connect the Emulator (J-Link or I-jet) to a free USB port on your computer.
3) Connect the IAR I-Jet to the RSK+RZN2L board ensuring that it is plugged in to the header “J20”.

The figure below is when a I-jet is used as Emulator.

![Figure 12: Jumper Position of JTAG Connection for RSK+RZN2L](image)

If you use J-Link OB on RSK+RZN2L board,
1) Open the jumper pin (J9) for switching the debug connection so that RSK+RZN2L can use J-Link OB on the board.
2) Connect the micro-USB type-B to J-Link OB USB connector (J10), and then the LED4 is lighted.

![Figure 13: J-Link OB Connection Settings for RSK+RZN2L](image)
2.6.3 Power Supply

Power is supplied using a USB cable (Type-C) or an AC / DC adapter.

- When using a USB cable (Type-C), connect it to the USB connector “CN5” of the RSK+RZN2L board.
- When connecting the AC / DC adapter, connect it to the USB connector “CN6” of the RSK+RZN2L board.

The figure below is when a USB cable (Type-C) is used.

Figure 14: How to Power Supply for RSK+RZN2L
3. **e² studio Setup**

3.1 **What is e² studio?**
Renesas e² studio is a development tool encompassing code development, build, and debug. e² studio is based on the open-source Eclipse IDE and the associated C/C++ Development Tooling (CDT).

When developing for RZ/T2, RZ/N2 MPUs, e² studio hosts the Renesas Flexible Software Package (FSP). FSP provides a wide range of time saving tools to simplify the selection, configuration, and management of modules and threads, to easily implement complex applications.

3.2 **e² studio Prerequisites**

3.2.1 **Windows PC Requirements**

The following are the Windows PC requirements to use e² studio:

For Windows 64-bit version

- Windows® 11 (64-bit version)
- Windows® 10 (64-bit version)
- Windows® 8.1 (64-bit version)
- Memory capacity: We recommend 8 GB or more. At least 4 GB.
- Capacity of hard disk: At least 2 GB of free space.
- Display: Graphics resolution should be at least 1024 x 768, and the mode should display at least 65,536 colors.
- Interface: USB 2.0
- Microsoft Visual C++ 2010 SP1 runtime library *1
- Microsoft Visual C++ 2015-2019 runtime library *1

*1. This software will be installed at the same time as the e² studio.

3.2.2 **Installing e² studio, Platform Installer and FSP Package**

Detailed installation instructions for the e² studio and the FSP are available on the Renesas website. Review the release notes for e² studio to ensure that the e² studio version supports the selected FSP version. The starting version of the installer includes all features of the RZ/T2, RZ/N2 MPUs.

3.2.3 **Choosing a Toolchain**

The GNU ARM Embedded Toolchain (version 12.2.1.arm-12-24) is required.

If the version of the toolchain has not been installed, please download the toolchain from ARM Developer website, and install it.

3.2.4 **Licensing**

FSP licensing includes full source code, limited to Renesas hardware only.
4. Tutorial: Your First RZ/T2, RZ/N2 MPU Project – Blinky

4.1 Tutorial Blinky

The goal of this tutorial is to quickly get acquainted with the Flexible Platform by moving through the steps of creating a simple application using e² studio and running that application on an RZ/T2, RZ/N2 MPU board.

4.2 What Does Blinky Do?

The application used in this tutorial is Blinky, traditionally the first program run in a new embedded development environment.

Blinky is the “Hello World” of microprocessors. If the LED blinks you know that:

- The toolchain is setup correctly and builds a working executable image for your chip.
- The debugger has installed with working drivers and is properly connected to the board.
- The board is powered up and its jumper and switch settings are probably correct.
- The microprocessor is alive, the clocks are running, and the memory is initialized.
4.3 Create a New Project for Blinky

The creation and configuration of an RZ/T and RZ/N C/C++ FSP Project is the first step in the creation of an application. The base RZ/T2 pack and RZ/N2 packs include a pre-written Blinky example application.

Follow these steps to create an RZ/T2, RZ/N2 MPU project:

1. In e² studio, click File > New > C/C++ Project.

![Figure 15: New C/C++ Project](image)

2. Select either one depending on your RZ/T2, RZ/N2 MPU and RSK board.
   - Renesas RZ > Renesas RZ/T C/C++ FSP Project
   - Renesas RZ > Renesas RZ/N C/C++ FSP Project

3. Click Next.

![Figure 16: Renesas RZ C/C++ FSP Project](image)

(Continued on next page)
4. Assign a name to this new project. Blinky is a good name to use for this tutorial.
5. Click Next. The Project Configuration window shows your selection.

![Figure 17: e² studio Project Configuration Window (Part 1)](image)

(Continued on next page)
6. Select the board support package by selecting the name of your board from the drop-down list. In this tutorial, please select either one depending on your device and RSK board.
   - RSK+RZT2M (RAM execution without flash memory)
   - RSK+RZT2L (RAM execution without flash memory)
   - RSK+RZN2L (RAM execution without flash memory)

7. Select GNU ARM Embedded in Toolchains and version is **12.2.1.arm-12-24** as its toolchain version, and click Next.
   - If there is NOT the 12.2.1.arm-12-24 version of GNU ARM Embedded Toolchain, please download the version of the toolchain from ARM Developer website and install it.

![Figure 18: e² studio Project Configuration Window (Part 2)](image)

(Continued on next page)
8. Select the **build artifact** and RTOS.

![Figure 19: e² studio Project Configuration Window (Part 3)](image)

(Continued on next page)
9. Select the Blinky template for your board and click Finish.

![Figure 20: e² studio Project Configuration Window (Part 4)](image)

Once the project has been created, the name of the project will show up in the Project Explorer window of e² studio. Now click the Generate Project Content button in the top right corner of the Project Configuration window to generate your board specific files.

![Figure 21: e² studio Project Configuration Tab](image)

Your new project is now created, configured, and ready to build.
4.3.1 Details about the Blinky Configuration

The Generate Project Content button creates configuration header files, copies source files from templates, and generally configures the project based on the state of the Project Configuration screen.

For example, if you check a box next to a module in the Components tab and click the Generate Project Content button, all the files necessary for the inclusion of that module into the project will be copied or created. If that same check box is then unchecked those files will be deleted.

4.3.2 Configuring the Blinky Clocks

By selecting the Blinky template, the clocks are configured by e² studio for the Blinky application.

The clock configuration tab (see 6.3.3 Configuring Clocks) shows the Blinky clock configuration. The Blinky clock configuration is stored in the BSP clock configuration file.

4.3.3 Configuring the Blinky Pins

By selecting the Blinky template, the GPIO pins used to toggle some of LEDs are configured by e² studio for the Blinky application.

The pin configuration tab shows the pin configuration for the Blinky application (see 6.3.4 Configuring Pins). The Blinky pin configuration is stored in the BSP configuration file.

4.3.4 Configuring the Parameters for Blinky Components

The Blinky project automatically selects the following HAL components in the Components tab:

- r_ioport

To see the configuration parameters for any of the components, check the Properties tab in the HAL window for the respective drivers (see 6.5 Adding and Configuring HAL Drivers).

4.3.5 Where is main()?

The main function is located in:

- `<RZT2 FSP project>/rzt_gen/main.c`.
- `<RZN2 FSP project>/rzn_gen/main.c`.

It is one of the files that are generated during the project creation stage and only contains a call to hal_entry(). For more information on generated files, see 6.5 Adding and Configuring HAL Drivers.

4.3.6 Blinky Example Code

The blinky application is stored in the hal_entry.c file. This file is generated by e² studio when you select the Blinky Project template and is located in the project’s folder `<project>/src/` folder.

The application performs the following steps:

1. Get the LED information for the selected board by `bsp_leds_t` structure.
2. Initialize output level for LED pin to LOW using `R_BSP_PinClear(BSP_IO_REGION_SAFE, (bsp_io_port_pin_t) leds.p_leds[i])`.
3. Use `R_BSP_PinToggle (BSP_IO_REGION_SAFE, (bsp_io_port_pin_t) leds.p_leds[i])` to set the output level to the LED pin.
4. `R_BSP_SoftwareDelay(delay, bsp_delay_units)` waits for a certain period of time. Then run #3 again.
4.4  Build the Blinky Project

Highlight the new project in the Project Explorer window by clicking on it and build it.

There are three ways to build a project:

1. Click on Project in the menu bar and select Build Project.
2. Click on the hammer icon.
3. Right-click on the project and select Build Project.

Figure 22: e² studio Project Explorer Window

Once the build is complete a message is displayed in the build Console window that displays the final image file name and section sizes in that image.

Figure 23: e² studio Project Build Console
4.5 Debug the Blinky Project

4.5.1 Debug Prerequisites

To debug the project on a board, you need the followings:

- The board to be connected to e² studio
- The debugger to be configured to talk to the board.
- The application to be programmed to the microprocessor.

Applications run from the internal ram of your microprocessor. To run or debug the application, the application must first be programmed to ram by JTAG debugger.

RSK board has a JTAG header and requires an external JTAG debugger to the header.

4.5.2 Debug Steps

To debug the Blinky application, follow these steps:

1. Configure the debugger for your project by clicking Run > Debugger Configurations ... or by selecting the drop-down menu next to the bug icon and selecting Debugger Configurations ...

![Figure 24: e² studio Debug Icon](image)

![Figure 25: e² studio Debugger Configurations Selection Option](image)

(Continued on next page)
2. Select your debugger configuration in the window. If it is not visible, then it must be created by clicking the New icon in the top left corner of the window. Once selected, the **Debug Configuration** window displays the **Debug configuration** for your **Blinky** project.

![Debug Configuration Window](image)

**Figure 26**: e² studio Debugger Configurations Window with Blinky Project

(Continued on next page)
If you use RAM execution without flash memory boot mode, it needs following configuration.

- **Debugger > Connection Settings > Connection**
  - Set No to **Reset after download** (Available in e² studio 2023-07 and later versions) to avoid resetting MPU after program download
  - Set Yes to **Set CPSR(5bit) after download** (Available in e² studio 2023-04 and later versions) to set the CPSR register value of CR52 general register before running the application.

![Debug Configuration Window](image)

**Figure 27**: e² studio Debugger Configurations Window with Blinky Project

3. Click **Debug** to begin debugging the application.

![Debug Progress](image)

**Figure 28**: Start Debugging
4.5.3 Details about the Debug Process

In debug mode, e\textsuperscript{2} studio executes the following tasks:

1. Downloading the application image to the microprocessor and programming the image to the internal memory.
2. Setting a breakpoint at \texttt{main()}.
3. Setting the stack pointer register to the stack.
4. Loading the program counter register with the address of the \texttt{system_init()}.
5. Displaying the startup code where the program counter points to.

![e\textsuperscript{2} studio Debugger Memory Window]

Figure 29: e\textsuperscript{2} studio Debugger Memory Window
4.6 Run the Blinky Project

While in Debug mode, click Run > Resume or click on the Play icon twice.

The following LEDs on the board should now be blinking.

- RSK+RZ/T2M: LED0~1 (CPU0)
- RSK+RZ/T2L: LED0~6 (including LEDx_ESC_xxx)
- RSK+RZ/N2L: LED0~3
5. FSP Smart Configurator User Guide

5.1 What is FSP Smart Configurator?
The Renesas FSP Smart Configurator (FSP SC) is a desktop application designed to configure device hardware such as clock set up and pin assignment as well as initialization of FSP software components when using a 3rd-party IDE and toolchain.

For creating RZ/T2 and RZ/N2 project, the FSP SC can currently be used with
- IAR EWARM with IAR toolchain for Arm

Projects can be configured, and the project content generated in the same way as in e² studio. Please refer to 5.2 Configuring a Project section for more details.

5.2 Tutorial Blinky
The goal of this tutorial is to quickly get acquainted with the Flexible Platform by moving through the steps of creating a simple application using FSP SC and 3rd-party IDE and running that application on an RZ/T2, RZ/N2 MPU board.

The application used in this tutorial is Blinky, traditionally the first program run in a new embedded development environment.

Blinky is the “Hello World” of microprocessors. If the LED blinks you know that:
- The toolchain is setup correctly and builds a working executable image for your chip.
- The debugger has installed with working drivers and is properly connected to the board.
- The board is powered up and its jumper and switch settings are probably correct.
- The microprocessor is alive, the clocks are running, and the memory is initialized.

5.3 Using Smart Configurator with IAR EWARM
IAR EWARM includes support for Renesas RZ/T2, RZ/N2 devices. These can be set up as bare metal designs within IAR EWARM. However, most RZ/T2, RZ/N2 developers will want to integrate RZ/T2, RZ/N2 FSP drivers and middleware into their designs. SC will facilitate this.

FSP SC generates a “Project Connection” file that can be loaded directly into IAR EWARM to update project files.

5.3.1 Prerequisites
- IAR EWARM installed and licensed.
  ➢ Please refer to IAR systems website regarding IAR EWARM.
- FSP SC and FSP Pack installed.
  ➢ Please refer to Renesas website regarding to FSP SC and FSP Pack.

Note for RZ/T2L:
If you use the IAR EWARM 9.32.1 to debug RZ/T2L FSP project, please apply the following patch file.
- RZ/T2L: EWARM_Patch_for_RZT2L_rev1.0.zip
  ➢ This patch file is available in http://www.renesas.com/rzt2l.

Regarding how to apply the patch, please read the readme file in patch file.
5.3.2 Create a New Project

The following steps are required to create a project using IAR EWARM, FSP SC and FSP.

1. Start the FSP Smart Configurator.
   - FSP Smart Configurator is installed in the following path as default.
     - For RZ/T2M and RZ/T2L, it is installed in C:\Renesas\rzt\sc_vYYYY-MM_fsp_vX.X.X\eclipse\rasc.exe
     - For RZ/N2L, it is installed in C:\Renesas\rzn\sc_vYYYY-MM_fsp_vX.X.X\eclipse\rasc.exe

2. Select the File > New > FSP Project…
   - This step may be unnecessary depending on old FSP SC version.

![Figure 31: FSP SC New Project](image)
3. Enter a project folder and project name.

![FSP SC Project Settings](image)

*Figure 32: FSP SC Project Settings*

(Continued on next page)
4. Select the **FSP** version.

5. Select the **Board** for your application.
   - You can select an existing RZ/T2, RZ/N2 MPU Evaluation Kit or select Custom User Board for any of the RZ/T2, RZ/N2 MPU devices with your own BSP definition.
   - Here, select either of following boards to create a FSP project for RSK board.
     - RSK+RZT2M (RAM execution without flash memory)
     - RSK+RZT2L (RAM execution without flash memory)
     - RSK+RZN2L (RAM execution without flash memory)

6. Select **IDE Project Type**.
   - Here, select **IAR EWARM**.
   - As the Toolchain, IAR Toolchain for ARM is preselected.

7. Click **Next**.

---

![Image](image_url)

**Figure 33 : Target Device and IDE Selections**

(Continued on next page)
8. Select RTOS.
   ➢ Here, select No RTOS for proceeding the following tutorial.
9. Click Next.

![RTOS Selection](image)

Figure 34: RTOS Selection

(Continued on next page)
10. Select a **project template** from the list of available templates.
    ➢ By default, this screen shows the templates that are included in your current RZ/T MPU Pack.
    ➢ Here, select Bare Metal – Blinky for proceeding the following tutorial.
    ➢ If you want to develop your own application, select the basic template for your board, **Bare Metal – Minimal**.

11. Click **Finish**.

![Figure 35: Template Selection](image)

(Continued on next page)
12. **Configure** the FSP configuration by referring to Chapter 6.3 “Configuring a Project”.
   - Here, skips this configuration step for proceeding the following tutorial.

13. On completion of the FSP configuration, press **Generate Project Content**.

![Figure 36 : FSP Project Configuration and Generation](image)

A new IAR EWARM project file will be generated in the project path.

14. Double click IAR EWARM Workspace file (.eww) to open IAR EWARM with workspace.

![Figure 37 : FSP Project Workspace](image)
5.3.2.1 NOTE: Configure IAR EWARM Project [Only RZ/N2L]

1. Click on **Project** and then click on **Option…** to open project option window.

![IAR EWARM Workspace Window](image)

**Figure 38 : IAR EWARM Workspace Window**

(Continued on next page)
2. Select **Debugger** category, and select **Setup** tab.
3. Select **I-jet** as Driver.
4. Check the **Override default** check box.

![Options for node "NewJar_project"](image)

**Figure 39**: Debugger Options (Setup)

(Continued on next page)
5. Select I-Jet category, and select Trace tab.
6. Select None as Mode.

![Options for node "New_IAR_project"](image)

Figure 40: I-jet Options (Trace)

The IAR EWARM project setting is completed.
5.3.3 Build the Project

Click on Project -> Make from menu bar or Make button on tool bar to build.

Figure 41: Make Button

Figure 42: Build Message Console

Once the build is completed, the build message is displayed in the Build Console window that displays compilation target files and the number of error/warnings.
5.3.4 Download & Debug the Project

Click on **Project -> Download and debug** from menu bar or **Download and Debug** button on tool bar to download and debug.

![Figure 43: Download and Debug Button](image)

(Continued on next page)
Once the download is completed and the debug is started, the program breaks at the beginning of `main` in `main.c`.

![Figure 44: Starting Debug](image)

Click on **Debug->Go** from menu bar or **Go** button on tool bar to run this program.

![Figure 45: Go Button](image)

(Continued on next page)
The blinky application is stored in the hal_entry.c file. This file is generated by FSP SC when you select the Blinky Project template and is located in the project’s src/ folder. In IAR EWARM workspace view, the hal_entry.c is registered Flex Software > Program Entry.

The application performs the following steps:
1. Get the LED information for the selected board by bsp_leds_t structure.
2. Initialize output level for LED pin to LOW using R_BSP_PinClear(BSP_IO_REGION_SAFE, (bsp_io_port_pin_t) leds.p_leds[i]).
3. Use R_BSP_PinToggle (BSP_IO_REGION_SAFE, (bsp_io_port_pin_t) leds.p_leds[i]) to set the output level to the LED pin.
4. R_BSP_SoftwareDelay(delay, bsp_delay_units) waits for a certain period of time. Then run #3 again.

On debugging on IAR EWARM, the break point can be set by click the left space next to line number.

(Continued on next page)
By using the break point and the **Debug** menu or **Debug** tool bar, you can check the behavior of the Blinky application step by step.

![Debug Menu](image)

**Figure 47 : Debug Menu**

When clinking **Go** button, the following LEDs on the board should now be blinking.

- RSK+RZ/T2M: LED0~1 (CPU0)
- RSK+RZ/T2L: LED0~6 (including LEDx_ESC_xxx)
- RSK+RZ/N2L: LED0~3
5.4 Re-configuring Project with FSP SC

For proceeding the tutorial with Blinky project, the FSP configuration steps of the Blinky project was skipped in this chapter. The FSP SC can be launched from IAR EWARM or command prompt, and the FSP project configuration can be re-configured by FSP SC.

There are two ways to launch FSP Smart Configurator with an exciting project.

5.4.1 Launch FSP Smart Configurator from IAR EWARM

1. Select “Tools -> Configure Tools…”
2. Select “New” and fill in the fields as follows:
   - Menu Text: FSP Smart Configurator
   - Command: $RASC_EXE_PATH$
   - Argument: --compiler IAR configuration.xml
   - Initial Directory: $PROJ_DIR$

![Figure 48: Settings to Launch FSP SC from IAR EWARM](image)

5.4.2 Launch from the Command Prompt.

1. Open command prompt window.
2. Move to the folder where the created project is located.
3. Execute the following command.
   - {FSP Smart Configurator installation folder} \ eclipse \ rasc.exe --compiler IAR configuration.xml
6. FSP Configuration Users Guide

6.1 What is a Project?

In e² studio, all FSP applications are organized in RZ/T2, RZ/N2 MPU projects. Setting up an RZ/T2, RZ/N2 MPU project involves:

1. Create a Project
2. Configuring a Project

These steps are described in detail in the next two sections. When you have existing projects already, after you launch e² studio and select a workspace, all projects previously saved in the selected workspace are loaded and displayed in the Project Explorer window. Each project has an associated configuration file named configuration.xml, which is located in the project’s root directory.

Figure 49: e² studio Project Configuration File

Double-click on the configuration.xml file to open the RZ/T2, RZ/N2 MPU Project Editor. To edit the project configuration, make sure that the FSP Configuration perspective is selected in the upper right-hand corner of the e² studio window. Once selected, you can use the editor to view or modify the configuration settings associated with this project.

Figure 50: e² studio FSP Configuration Perspective

(Continued on next page)
Note:
Whenever the RZ/T2, RZ/N2 project configuration (that is, the configuration.xml file) is saved after configuring the project, a verbose RZ/T2, RZ/N2 Project Report file (rz_t2_cfg.txt, or rzn_cfg.txt) with all the project settings is generated. The format allows differences to be easily viewed using a text comparison tool. The generated file is located in the project root directory.

![Figure 51: RZ/T2, RZ/N2 Project Report](image1)

The RZ/T2, RZ/N2 Project Editor has several tabs. The configuration steps and options for individual tabs are discussed in the following sections.

Note:
The tabs available in the RZ/T2, RZ/N2 Project Editor depend on the e² studio version and the layout may vary slightly, however the functionality should be easy to follow.

![Figure 52: RZ/T2, RZ/N2 Project Editor Tabs](image2)
6.2 Create a Project

6.2.1 Creating a New Project

For RZ/T2, RZ/N2 MPU applications, generate a new project using the following steps:

1. Click on File > New > C/C++ Project.

![Figure 53: New RZ/T2, RZ/N2 MPU Project](image)

2. Then click on the Renesas RZ/T C/C++ FSP Project template for the type of project you are creating.

![Figure 54: New Project Templates](image)

(Continued on next page)
3. Select a project name and location.
4. Click Next.

Figure 55: RZ/T2, RZ/N2 MPU Project Generator (Part 1)
6.2.2 Selecting a Board and Toolchain

In the Project Configuration window select the hardware and software environment:

1. Select the **FSP version**.
2. Select the **Board** and **Device** for your application.

**Note:**

You can select an existing RZ/T2, RZ/N2 MPU Evaluation Kit (Such as RSK) or can select **Custom User Board** for any of the RZ/T2, RZ/N2 MPU devices with your own BSP definition.

When you use the RZ/T2, RZ/N2 MPU Evaluation Kit,

- First, please set the **Board** to the Evaluation Kit and the boot mode which you use.
- In this case, please don’t change the **Device** which is automatically set to the device which RSK board uses.

When you use **Custom User Board**,

- First, please set the **Device** to your device on your board.
- Second, please set the Board to **Custom User Board** with the boot mode which you use.

3. The **Toolchain** selection defaults to **GNU Arm Embedded**.
   - Select the **Toolchain version**.
4. This should default to the installed toolchain version.
   - Select the **Debugger**.
5. The J-Link Arm Debugger is preselected.
6. Click **Next**.

![Figure 56: RZ/T2, RZ/N2 MPU Project Generator (Part 2)](image-url)
6.2.3 Selecting a Project Template

In the next window, select the build artifact and RTOS.

![Figure 57: RZ/T2, RZ/N2 MPU Project Generator (Part 3)](image)

(Continued on next page)
In the next window, select a project template from the list of available templates. By default, this screen shows the templates that are included in your current RZ/T2, RZ/N2 MPU Pack. Once you have selected the appropriate template, click Finish.

Note:
If you want to develop your own application, select the basic template for your board, Bare Metal – Minimal.

Figure 58: RZ/T2, RZ/N2 MPU Project Generator (Part 4)

(Continued on next page)
When the project is created, e² studio displays a summary of the current project configuration in the RZ/T2, RZ/N2 MPU Project Editor.

![RZ/T2, RZ/N2 MPU Project Editor and Available Editor Tabs](image)

**Figure 59 : RZ/T2, RZ/N2 MPU Project Editor and Available Editor Tabs**

On the bottom of the RZ/T2, RZ/N2 MPU Project Editor view, you can find the tabs for configuring multiple aspects of your project:

- With the **Summary** tab, you can see all the key characteristics of the project: board, device, toolchain, and more.
- With the **BSP** tab, you can change board specific parameters from the initial project selection.
- With the **Clocks** tab, you can configure the MPU clock settings for your project.
- With the **Pins** tab, you can configure the electrical characteristics and functions of each port pin.
- With the **Interrupts** tab, you can add new user events/interrupts.
- With the **Event Links** tab, you can configure events used by the Event Link Controller.
- With the **Stacks** tab, you can add and configure FSP modules. For each module selected in this tab, the **Properties** window provides access to the configuration parameters, interrupt selections.
- The **Components** tab provides an overview of the selected modules. Although you can also add drivers for specific FSP releases and application sample code here, this tab is normally only used for reference.
6.3 Configuring a Project

Each of the configurable elements in an FSP project can be edited using the appropriate tab in the RZ/T2, RZ/N2 Configuration editor window. Importantly, the initial configuration of the MPU after reset and before any user code is executed is set by the configuration settings in the BSP tab. When you select a project template during project creation, e² studio configures default values that are appropriate for the associated board. You can change those default values as needed. The following sections detail the process of configuring each of the project elements for each of the associated tabs.

6.3.1 Summary Tab

![Figure 60: Configuration Summary Tab](image)

The Summary tab, seen in the above figure, identifies all the key elements and components of a project. It shows the target board, the device, toolchain and FSP version. Additionally, it provides a list of all the selected software components and modules used by the project. This is a more convenient summary view when compared to the Components tab.
6.3.2 Configuring the BSP

The BSP tab shows the currently selected board (if any) and device. The Properties view is located in the lower left of the Project Configurations view as shown below.

**Note:**

If the Properties view is not visible, click **Window > Show View > Properties** in the top menu bar.

---

The **Properties** view shows the configurable options available for the BSP. These can be changed as required. The BSP is the FSP layer above the MPU hardware. e² studio checks the entry fields to flag invalid entries. For example, only valid numeric values can be entered for the stack size.

When you click the **Generate Project Content** button, the BSP configuration contents are written to:

- `rz_tcfg/fsp_cfg/bsp/bsp_cfg.h`, or
- `rzn_cfg/fsp_cfg/bsp/bsp_cfg.h`

This file is created if it does not already exist.

**Warning:**

Do not edit this file as it is overwritten whenever the Generate Project Content button is clicked.
6.3.3 Configuring Clocks

The Clocks tab presents a graphical view of the MPU’s clock tree, allowing the various clock dividers and sources to be modified.

![Configuration Clocks Tab](image)

When you click the Generate Project Content button, the clock configuration contents are written to:

- `rzt_gen/bsp_clock_cfg.h`, or
- `rzn_gen/bsp_clock_cfg.h`

This file will be created if it does not already exist.

**Warning:**

Do not edit this file as it is overwritten whenever the *Generate Project Content* button is clicked.
6.3.4 Configuring Pins

The **Pins** tab provides flexible configuration of the MPU’s pins. As many pins are able to provide multiple functions, they can be configured on a peripheral basis. For example, selecting a serial channel via the SCI peripheral offers multiple options for the location of the receive and transmit pins for that module and channel. Once a pin is configured, it is shown as green in the **Package** view.

**Note:**
If the **Package** view window is not open in e²studio, select **Window > Show View > Pin Configurator > Package** from the top menu bar to open it.

The **Pins** tab simplifies the configuration of large packages with highly multiplexed pins by highlighting errors and presenting the options for each pin or for each peripheral. If you selected a project template for a specific board such as RSK+RZT2M, some peripherals connected on the board are preselected.

![Figure 63: Pin Configuration](image)

(Continued on next page)
The pin configurator includes a built-in conflict checker, so if the same pin is allocated to another peripheral or I/O function the pin will be shown as red in the package view and also with white cross in a red square in the Pin Selection pane and Pin Configuration pane in the main Pins tab. The Pin Conflicts view provides a list of conflicts, so conflicts can be quickly identified and fixed.

In the example shown below, port P162 is already used by the GPIO, and the attempt to connect this port to the Serial Communications Interface (SCI) results in a dangling connection error. To fix this error, select another port from the pin drop-down list or disable the GPIO in the Pin Selection pane on the left side of the tab.

Figure 64: Conflict Checker in Pin Configuration

(Continued on next page)
The pin configurator also shows a package view and the selected electrical or functional characteristics of each pin.

![Figure 65: Pin Configurator Package View](image)

When you click the **Generate Project Content button**, the pin configuration contents are written to:

- `rzt_gen\bsp_pin_cfg.h`, or
- `rzn_gen\bsp_pin_cfg.h`

This file will be created if it does not already exist.

**Warning:**

Do not edit this file as it is overwritten whenever the **Generate Project Content** button is clicked.
6.4 Configuring Interrupts from the Stacks Tab

You can use the Properties view in the Stacks tab to enable interrupts by setting the interrupt priority. Select the driver in the Stacks pane to view and edit its properties.

![Configuring Interrupts in the Stacks Tab](image)

Figure 66: Configuring Interrupts in the Stacks Tab
6.4.1 Creating Interrupts from the Interrupts Tab

On the Interrupts tab, the interrupt of the driver selected in the Stacks tab is registered.

And the user can add a peripheral interrupt created by the user's own. This can be done by adding a new event via the New User Event button.

![Figure 67: Configuring Interrupt in Interrupt Tab](image)

And the user can add a peripheral interrupt created by the user's own. This can be done by adding a new event via the New User Event button.
### 6.4.2 Viewing Event Links

The Event Links tab can be used to view the Event Link Controller events. The events are sorted by peripheral to make it easy to find and verify them.

![Figure 68: Viewing Event Links](image)

Like the Interrupts tab, user-defined event sources and destinations (producers and consumers) can be defined by clicking the relevant **New User Event** button. Once a consumer is linked to a producer the link will appear in the **Allocations** section at the bottom.

**Note:**

When selecting an ELC event to receive for a module (or when manually defining an event link), only the events that are made available by the modules configured in the project will be shown.
6.5 Adding and Configuring HAL Drivers

For applications that run outside or without the RTOS, you can add additional HAL drivers to your application using the HAL/Common thread. To add drivers, follow these steps:

1. Click on the HAL/Common icon in the Stacks pane. The Modules pane changes to HAL/Common Stacks.
2. Click New Stack to see a drop-down list of HAL level drivers available in the FSP.
3. Select a driver from the menu New Stack > Driver.

Figure 69: e² studio Project Configurator – Adding Drivers

5. Select the driver module in the HAL/Common Modules pane and configure the driver properties in the Properties view.

e² studio adds the following files when you click the Generate Project Content button:

- The selected driver module and its files to the rzt/fsp or rzn/fsp directory
- The main() function and configuration structures and header files for your application as shown in the table below.

Table 5 Generate Contents on Smart Configurator

<table>
<thead>
<tr>
<th>File</th>
<th>Contents</th>
<th>Overwritten by Generate Project Content?</th>
</tr>
</thead>
<tbody>
<tr>
<td>rzt_gen/main.c or</td>
<td>Contains main() calling generated and user code. When called, the BSP</td>
<td>Yes</td>
</tr>
<tr>
<td>rzn_gen/main.c</td>
<td>already has Initialized the MPU.</td>
<td></td>
</tr>
<tr>
<td>rzt_gen/hal_data.c or</td>
<td>Configuration structures for HAL Driver only modules.</td>
<td>Yes</td>
</tr>
<tr>
<td>rzn_gen/hal_data.c</td>
<td></td>
<td></td>
</tr>
<tr>
<td>rzt_gen/hal_data.h or</td>
<td>Header file for HAL driver only modules.</td>
<td>Yes</td>
</tr>
<tr>
<td>rzn_gen/hal_data.h</td>
<td></td>
<td></td>
</tr>
<tr>
<td>src/hal_entry.c</td>
<td>User entry point for HAL Driver only code. Add your code here.</td>
<td>No</td>
</tr>
</tbody>
</table>

The configuration header files for all included modules are created or overwritten in this folder:

- rzt_cfg/fsp_cfg or
- rzn_cfg/fsp_cfg
6.6 Reviewing and Adding Components

The Components tab enables the individual modules required by the application to be included or excluded. Modules common to all RZ MPU projects are preselected. All modules that are necessary for the modules selected in the Stacks tab are included automatically. You can include or exclude additional modules by ticking the box next to the required component.

![Components Tab](image)

Figure 70: Components Tab

Clicking the Generate Project Content button copies the .c and .h files for each selected component into the following folders:

- `rz/fsp/inc/api`
- `rz/fsp/inc/instances`
- `rz/fsp/src/bsp`
- `rz/fsp/src/<Driver_Name>`

or

- `rzn/fsp/inc/api`
- `rzn/fsp/inc/instances`
- `rzn/fsp/src/bsp`
- `rzn/fsp/src/<Driver_Name>`

e² studio also creates configuration files in the following folder with configuration options set in the Stacks tab.

- `rz_cfg/fsp_cfg`
- `rzn_cfg/fsp_cfg`
Appendix. Known Issues

This chapter describes the known issues regarding the current version of FSP and related platform software. Most of the issues may require users to follow some manual operations to resolve the issues or to avoid the problems caused by the issues. Please follow the operations in the description of the issues if you use the features related to the issues. The grayed-out items have been resolved.

The known issues are categorized into two main groups, FSP Configuration and FSP Modules.

- FSP Configuration
  - e² studio and FSP SC have various configuration features worked on GUI with FSP.
  - Regarding the overview of each configuration feature (GUI tab) provided as a part of FSP configuration in e² studio and FSP SC, please see the chapter 6. “FSP Configuration Users Guide”.

- FSP Modules
  - The FSP provides HAL drivers and BSP configured by FSP Configuration on e² studio and FSP SC.
  - Regarding their features, usage notes and API references, please see the related file “FSP Documentation”.

Table 6 List of Known Issues

<table>
<thead>
<tr>
<th>No.</th>
<th>Title</th>
<th>Target Device</th>
<th>Category</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>“r_gmac” may be showed as “r_ether” incorrectly.</td>
<td>✓</td>
<td>FSP Configuration, Stacks</td>
</tr>
<tr>
<td>2</td>
<td>“Edge” can be selected as Transfer End Interrupt Detect Type in ”r_dmac”, but it cannot be used.</td>
<td>✓ ✓ ✓</td>
<td>FSP Configuration, Stacks</td>
</tr>
<tr>
<td>3</td>
<td>When the “Device” or “Board” selection in BSP tab is changed, the BSP properties are sometimes configured to incorrect configuration.</td>
<td>✓ ✓ ✓</td>
<td>FSP Configuration, BSP</td>
</tr>
<tr>
<td>4</td>
<td>(FSP SC ONLY) Device name is not output correctly depending on the selected device.</td>
<td>✓</td>
<td>FSP Configuration, BSP</td>
</tr>
<tr>
<td>5</td>
<td>Errors occur when changing board settings.</td>
<td>✓ ✓ ✓</td>
<td>FSP Configuration, BSP</td>
</tr>
<tr>
<td>6</td>
<td>Pin configuration error occurs in MPX-IO 16bit operating mode of “r_bsc”.</td>
<td>✓ ✓ ✓</td>
<td>FSP Configuration, Pins</td>
</tr>
<tr>
<td>7</td>
<td>Build error when using definition name of input/output external pins for module.</td>
<td>✓ ✓ ✓</td>
<td>FSP Configuration, Pins</td>
</tr>
<tr>
<td>8</td>
<td>“R_SCI_UART_BaudCalculate()” of “r_sci_uart” module properly works ONLY when its clock source is SCInASYNCLK and its frequency is 96MHz.</td>
<td>✓ ✓ ✓</td>
<td>FSP Modules, SCI UART</td>
</tr>
<tr>
<td>9</td>
<td>“R_SPI_CalculateBitrate()” of “r_spi” module properly works ONLY when its clock source is SPIInASYNCLK and its frequency is 96MHz.</td>
<td>✓ ✓ ✓</td>
<td>FSP Modules, SPI</td>
</tr>
<tr>
<td>10</td>
<td>A warning occurs when building “r_gmac” module with the gcc compiler.</td>
<td>✓ ✓</td>
<td>FSP Modules, Ethernet</td>
</tr>
<tr>
<td>11</td>
<td>In FSP Documentation, there is incorrect description in. “API Reference &gt; Modules &gt; Ethernet PHY” page.</td>
<td>✓ ✓</td>
<td>FSP Modules, Ethernet PHY</td>
</tr>
<tr>
<td>12</td>
<td>When using multiple interrupt handlers with different priority levels in FreeRTOS.</td>
<td>✓ ✓ ✓</td>
<td>FSP Modules, FreeRTOS</td>
</tr>
</tbody>
</table>
### No. 1 Resolved

<table>
<thead>
<tr>
<th>Title</th>
<th>“r_gmac” may be showed as “r_ether” incorrectly.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Target</td>
<td>RZ/T2M, RZ/N2L</td>
</tr>
<tr>
<td>Category</td>
<td>FSP Configuration, Stacks</td>
</tr>
<tr>
<td>Description</td>
<td>In Stacks tab, “r_gmac” may be showed as “r_ether” incorrectly.</td>
</tr>
<tr>
<td>Workaround</td>
<td>Please read the “r_ether” as “r_gmac”.</td>
</tr>
</tbody>
</table>

### No. 2

<table>
<thead>
<tr>
<th>Title</th>
<th>“Edge” can be selected as Transfer End Interrupt Detect Type in &quot;r_dmac&quot;, but it cannot be used.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Target</td>
<td>RZ/T2M, RZ/T2L, RZ/N2L</td>
</tr>
<tr>
<td>Category</td>
<td>FSP Configuration, Stacks</td>
</tr>
<tr>
<td>Description</td>
<td>“Edge” of interrupt detect type is not available due to a change in hardware specifications.</td>
</tr>
<tr>
<td>Workaround</td>
<td>Please don’t set Edge to Transfer End Interrupt Detect Type</td>
</tr>
</tbody>
</table>

### No. 3

<table>
<thead>
<tr>
<th>Title</th>
<th>When the “Device” or “Board” selection in BSP tab is changed, the BSP properties are sometimes configured to incorrect configuration.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Target</td>
<td>RZ/T2M, RZ/T2L, RZ/N2L</td>
</tr>
<tr>
<td>Category</td>
<td>FSP Configuration, BSP</td>
</tr>
<tr>
<td>Description</td>
<td>When the “Device” or “Board” selection in BSP tab is changed, the BSP properties are sometimes configured for incorrect configuration. Once this issue occurs, the project cannot be fixed to correct configuration.</td>
</tr>
<tr>
<td>Workaround</td>
<td>If changing the “Device” or “Board”, please reselect “FSP Version” from the drop-down list. If you want to change only the boot mode on the same board, please refer to Appendix. How to Change Boot Mode of FSP Project</td>
</tr>
</tbody>
</table>

(Continued on next page)
<table>
<thead>
<tr>
<th>No. 4</th>
<th>(FSP SC ONLY) Device name is not output correctly depending on the selected device.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Title</td>
<td>Device name is not output correctly depending on the selected device.</td>
</tr>
<tr>
<td>Target</td>
<td>RZ/T2M</td>
</tr>
<tr>
<td>Category</td>
<td>FSP Configuration, BSP</td>
</tr>
<tr>
<td>Description</td>
<td>If you create a project by selecting a single core device (R9A07G075M01xxx, R9A07G075M05xxx), the device setting will be “None” when you open the project in IAR EWARM. Please reselect device name from the device list in IAR EWARM project options. Options &gt; General Options &gt; Target &gt; Processor variant &gt; Device</td>
</tr>
<tr>
<td>Workaround</td>
<td>Please reselect device name from the device list in IAR EWARM project options. Options &gt; General Options &gt; Target &gt; Processor variant &gt; Device</td>
</tr>
</tbody>
</table>

(Continued on next page)
<table>
<thead>
<tr>
<th>No. 5</th>
<th>Deleted due to one of the issues with Known Issues No. 3</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Title</strong></td>
<td>Errors occur when changing board settings.</td>
</tr>
<tr>
<td><strong>Target</strong></td>
<td>RZ/T2L, RZ/N2L</td>
</tr>
<tr>
<td><strong>Category</strong></td>
<td>FSP Configuration, BSP</td>
</tr>
<tr>
<td><strong>Description</strong></td>
<td>Errors occur when changing board settings from RSK+RZN2L (RAM execution without flash memory) to RZN2L Custom User Board (RAM execution without flash memory) and from RSK+RZN2L (RAM execution without flash memory) to RZN2L Custom User Board (xSPI0 x1 boot mode).</td>
</tr>
</tbody>
</table>

1. Changed from RSK+RZN2L (RAM execution without flash memory) to RZN2L Custom User Board (RAM execution without flash memory)

   In this case, the build is successful, but the following screen is displayed after the build.

   ![Build failed screen](image)

2. Changed from RSK+RZN2L (RAM execution without flash memory) to RZN2L Custom User Board (xSPI0 x1 boot mode)

   bsp_mcu_device_pn_cfg.h is not generated and builds error occurs.

   ![Build failed screen](image)

   **Workaround**

   Please create a new project to change the board setting to RZN2L Custom User Board.

(Continued on next page)
No. 6

<table>
<thead>
<tr>
<th>Title</th>
<th>Pin configuration error occurs in MPX-IO 16bit operating mode of “r_bsc”.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Target</td>
<td>RZ/T2M, RZ/T2L, RZ/N2L</td>
</tr>
<tr>
<td>Category</td>
<td>FSP Configuration, Pins</td>
</tr>
<tr>
<td>Description</td>
<td>Pin assignment is an optional specification in MPX-IO 16bit operation mode of “r_bsc”, but an error will occur if Input/Output A1-A13 is not set.</td>
</tr>
</tbody>
</table>

**Workaround**

Please set “Custom” to “Operation Mode” of “r_bsc” in Pins tab when you use MPX-IO 16bit operation mode of “r_bsc”.

(Continued on next page)
### No. 7 Resolved

<table>
<thead>
<tr>
<th>Title</th>
<th>Build error when using definition name of input/output external pins for module.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Target</td>
<td>RZ/T2M, RZ/T2L, RZ/N2L</td>
</tr>
<tr>
<td>Category</td>
<td>FSP Configuration, Pins</td>
</tr>
<tr>
<td>Description</td>
<td>After code generation, the definition of input/output external pins for the module is generated in <code>fsp_cfg/bsp/bsp_pin_cfg.h</code>, but the defined values are not defined in FSP. When using the defined name in a user application, a build error occurs.</td>
</tr>
</tbody>
</table>

#### Workaround

Please add definition to read `IOPORT_PORT_mm_PIN_n` as `BSP_IO_PORT_mm_PIN_n` in `hal_entry`. Do NOT edit file `fsp_cfg/bsp/bsp_pin_cfg.h` because its contents will be overwritten.

An example of a setting:

When using ETH0_RXD0 (`IOPORT_PORT_10_PIN_1`), add definition of `#define IOPORT_PORT_10_PIN_1 (BSP_IO_PORT_10_PIN_1)` in `hal_entry.c`.

### No. 8

<table>
<thead>
<tr>
<th>Issue</th>
<th>“R_SCI_UART_BaudCalculate()” of “r_sci_uart” module properly works ONLY when its clock source is SCInASYNCCLK and its frequency is 96MHz.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Target</td>
<td>RZ/T2M, RZ/T2L, RZ/N2L</td>
</tr>
<tr>
<td>Category</td>
<td>FSP Modules, Serial Communication Interface (SCI) UART</td>
</tr>
<tr>
<td>Description</td>
<td>The “R_SCI_UART_BaudCalculate()” of “r_sci_uart” module works ONLY when its clock source is “SCInASYNCCLK” and its frequency is “96MHz”; therefore, when the module uses “PCLKM” as its clock source or the frequency is not 96MHz, the API function will be not work properly.</td>
</tr>
<tr>
<td>Workaround</td>
<td>The clock source and frequency are limited in Clocks and Stacks tab; therefore, you can NOT use the PCLKM clock and can NOT change the clock frequency.</td>
</tr>
</tbody>
</table>

(Continued on next page)
No. 9

<table>
<thead>
<tr>
<th>Issue</th>
<th>“R_SPI_CalculateBitrate()” of “r_spi” module properly works ONLY when its clock source is SPInASYNCCLK and its frequency is 96MHz.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Target</td>
<td>RZ/T2M, RZ/T2L, RZ/N2L</td>
</tr>
<tr>
<td>Category</td>
<td>FSP Modules, Serial Peripheral Interface</td>
</tr>
<tr>
<td>Description</td>
<td>The “R_SPI_BaudCalculate()” of “r_spi” module works ONLY when its clock source is “SPInASYNCCLK” and its frequency is “96MHz”; therefore, when the module uses “PCLKM” as its clock source or the frequency is not 96MHz, the API function will not work properly.</td>
</tr>
<tr>
<td>Workaround</td>
<td>The clock source and frequency are limited in Clocks and Stacks tab; therefore, you can NOT use the PCLKM clock and can NOT change the clock frequency.</td>
</tr>
</tbody>
</table>

No. 10

<table>
<thead>
<tr>
<th>Issue</th>
<th>A warning occurs when building “r_gmac” module with the gcc compiler.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Target</td>
<td>RZ/T2M, RZ/T2L</td>
</tr>
<tr>
<td>Category</td>
<td>FSP Modules, Ethernet</td>
</tr>
</tbody>
</table>
| Description | The following warning occurs when building “r_gmac” module with the gcc compiler.
```cpp
../rtt/fsp/src/r_gmac/r_gmac.c:2173:14: warning: the comparison always evaluates as 'false' for the pointer operand in `if (pp_phy_instance + (size_t)(port * 12) * offset) == NULL` [-Waddress]
            |   if (NULL == pp_phy_instance[port])
```
| Workaround | Please ignore this warning. |

No. 11

<table>
<thead>
<tr>
<th>Issue</th>
<th>In FSP Documentation, there is incorrect description in “API Reference &gt; Modules &gt; Ethernet PHY” page.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Target</td>
<td>RZ/T2M, RZ/N2L</td>
</tr>
<tr>
<td>Category</td>
<td>FSP Modules, Ethernet PHY</td>
</tr>
<tr>
<td>Description</td>
<td>In the “API Reference &gt; Modules &gt; Ethernet PHY” page in FSP Documentation, the default column description of “Select PHYs to use” configuration is incorrect.</td>
</tr>
<tr>
<td>Workaround</td>
<td>When reading the incorrect description, please replace the reading of it with follows.</td>
</tr>
</tbody>
</table>
|            | [Error]  
|            |   ➢ config.driver.ether_phy.phy_lsi.default,config.driver.ether_phy.phy_lsi.0,config.driver.ether_phy.phy_lsi.1,config.driver.ether_phy.phy_lsi.2,config.driver.ether_phy.phy_lsi.3,config.driver.ether_phy.phy_lsi.4  
|            | [Correction]  
|            |   ➢ All check boxes are enabled. |

(Continued on next page)
<table>
<thead>
<tr>
<th>No. 12</th>
<th>Issue</th>
<th>The interrupt number cannot be successfully acquired by the R_FSP_CurrentIrqGet() when multiple interrupt occurs.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Target</td>
<td>RZ/T2M, RZ/T2L, RZ/N2L</td>
<td>FSP Modules, FreeRTOS</td>
</tr>
<tr>
<td>Description</td>
<td>The interrupt number cannot be successfully acquired by the R_FSP_CurrentIrqGet() when using multiple interrupt handlers with different priority levels in FreeRTOS.</td>
<td></td>
</tr>
<tr>
<td>Workaround</td>
<td>Please modify the followings for the countermeasure against nested interrupts.</td>
<td></td>
</tr>
</tbody>
</table>

**Target File: port.c**

```c
void vApplicationIRQHandler (uint32_t ulICCIAR)
{
    #if 0
    /* Re-enable interrupts. */
    __asm("cpsie ");
    #endif
    bsp_common_interrupt_handler(ulICCIAR);
}
```

**Target File: bsp_irq.c**

```c
void bsp_common_interrupt_handler (uint32_t id)
{
    uint16_t gic_intid;
    /* Get interrupt ID (GIC INTID). */
    gic_intid = (uint16_t) (id & BSP_PRV_ID_MASK);
    #if VECTOR_DATA_IRQ_COUNT > 0
    if (BSP_CORTEX_VECTOR_TABLE_ENTRIES <= gic_intid)
    {
        /* Remain the interrupt number */
        g_current_interrupt_num[g_current_interrupt_pointer++] = (uint16_t) (gic_intid - BSP_CORTEX_VECTOR_TABLE_ENTRIES);
        __asm volatile "dm b"
    #if 1
    /* Enable nested interrupt. */
    __asm volatile "cpsie ";
    __asm volatile "is b";
    #endif
    /* Branch to an interrupt handler. */
    g_vector_table[(gic_intid - BSP_CORTEX_VECTOR_TABLE_ENTRIES)]();
    }
    else
    #endif
    {
        /* Remain the interrupt number */
        g_current_interrupt_num[g_current_interrupt_pointer++] = gic_intid;
        __asm volatile "dm b"
    #if 1
    /* Enable nested interrupt. */
    __asm volatile "cpsie ";
    __asm volatile "is b";
    #endif
    /* Branch to an interrupt handler. */
    g_sgi_ppi_vector_table[gic_intid]();
    }
    #if 1
    /* Enable nested interrupt. */
    __asm volatile "cpsie ";
    __asm volatile "is b";
    #endif
    g_current_interrupt_pointer--;
}
```
Appendix. Tool Software Limitations

This section describes the limitations regarding the tool software (e² studio, FSP SC) to create and debug FSP projects.

<table>
<thead>
<tr>
<th>No.</th>
<th>Title</th>
<th>Target Device</th>
<th>Category</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>When installing, please install into the default installation folder specified by installer.</td>
<td>✓ ✓ ✓</td>
<td>SC, FSP SC</td>
</tr>
<tr>
<td>2</td>
<td>Before pressing the reset button on the board, disconnect the e² studio connection first.</td>
<td>✓ ✓ ✓</td>
<td>e² studio</td>
</tr>
<tr>
<td>3</td>
<td>An error has occurred because the program download to the NOR flash area has failed. The download is successful on the second connection.</td>
<td>✓</td>
<td>e² studio</td>
</tr>
<tr>
<td>4</td>
<td>The user program cannot be stopped immediately after the device boot process.</td>
<td>✓ ✓ ✓</td>
<td>e² studio</td>
</tr>
<tr>
<td>5</td>
<td>When using e² studio installer, if checking the multiple check boxes such as “View Release Notes” and so on to show information on browser, the ONLY head item of checked items is shown.</td>
<td>✓ ✓ ✓</td>
<td>e² studio</td>
</tr>
<tr>
<td>6</td>
<td>The memory region usage of ATCM displayed in the Memory Usage window of e² studio is smaller than the actual size by memory region usage of DUMMY.</td>
<td>✓ ✓ ✓</td>
<td>e² studio</td>
</tr>
<tr>
<td>7</td>
<td>When debugging RAM execution without flash memory project with program written to flash memory, erasure flash memory before debugging.</td>
<td>✓ ✓ ✓</td>
<td>e² studio</td>
</tr>
<tr>
<td>8</td>
<td>Applying RZ/T2 FSP v.1.2.0 pack to a project that is already working with RZ/T2M FSP v.1.1.0 causes an error when connecting the debugger.</td>
<td>✓</td>
<td>IAR EWARM</td>
</tr>
</tbody>
</table>

No. 1

Limitation | When installing, please install into the default installation folder specified by installer.
--- | ---
Target Device | RZ/T2M, RZ/T2L, RZ/N2L
Category | Smart Configurator, FSP Smart Configurator
Description | When sharing a project between different PCs, build errors will occur if the installation folders are different.

No. 2 Resolved

Limitation | Before pressing the reset button on the board, disconnect the e² studio connection first.
--- | ---
Target | RZ/T2M, RZ/T2L, RZ/N2L
Category | e² studio
Description | If the reset button is pressed on the board while connected with e² studio, debugging will not be able to continue.

(Continued on next page)
### No. 3  Resolved

<table>
<thead>
<tr>
<th>Limitation</th>
<th>An error has occurred because the program download to the NOR flash area has failed. The download is successful on the second connection.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Target</td>
<td>RZ/T2M, RZ/N2L</td>
</tr>
<tr>
<td>Category</td>
<td>e² studio</td>
</tr>
<tr>
<td>Description</td>
<td>If the following error is displayed when connecting the debugger or when downloading the program, click the [OK] button to close the dialog and try connecting again.</td>
</tr>
</tbody>
</table>

![Error dialog](image)

### No. 4

<table>
<thead>
<tr>
<th>Limitation</th>
<th>The user program cannot be stopped immediately after the device boot process.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Target</td>
<td>RZ/T2M, RZ/T2L, RZ/N2L</td>
</tr>
<tr>
<td>Category</td>
<td>e² studio</td>
</tr>
<tr>
<td>Description</td>
<td>Immediately after the device boot process (boot code), the program cannot be stopped at the beginning of the user program (loader program). When debugging, please follows the guide in Appendix. How to Debug FSP Project with Flash Boot Mode.</td>
</tr>
</tbody>
</table>

(Continued on next page)
### No. 5 Invalid

<table>
<thead>
<tr>
<th>Limitation</th>
<th>When using e² studio installer, if checking the multiple check boxes such as “View Release Notes” and so on to show information on browser, the ONLY head item of checked items is shown.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Target</td>
<td>RZ/T2M, RZ/T2L, RZ/N2L</td>
</tr>
<tr>
<td>Category</td>
<td>e² studio</td>
</tr>
<tr>
<td>Description</td>
<td>For example, if checking “View Release Notes” check box and other check boxes on the following window, the ONLY “Release Notes” is shown, and the other contents are NOT shown.</td>
</tr>
</tbody>
</table>

(Continued on next page)
### No. 6

<table>
<thead>
<tr>
<th>Limitation</th>
<th>The memory region usage of ATCM displayed in the Memory Usage window of e² studio is smaller than the actual size by memory region usage of DUMMY.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Target</td>
<td>RZ/T2M, RZ/T2L, RZ/N2L</td>
</tr>
<tr>
<td>Category</td>
<td>e² studio</td>
</tr>
<tr>
<td>Description</td>
<td>The memory region usage of DUMMY shown in the Memory Usage window is the region used by the system. The DUMMY is placed in ATCM, however memory region usage of ATCM does NOT include its size. Therefore, please note that the memory region usage of ATCM displayed is smaller than the actual size by the memory region usage of DUMMY.</td>
</tr>
</tbody>
</table>

![Memory Region Usage](image)

### No. 7

<table>
<thead>
<tr>
<th>Limitation</th>
<th>When debugging RAM execution without flash memory project with program written to flash memory, erase flash memory before debugging.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Target</td>
<td>RZ/T2M, RZ/T2L, RZ/N2L</td>
</tr>
<tr>
<td>Category</td>
<td>e² studio</td>
</tr>
<tr>
<td>Description</td>
<td>If you run a RAM execution without flash memory project with a program written in flash memory, it may be impossible to debug the project. When erasing flash memory, please follows the guide in Appendix. How to Erase Flash Memory</td>
</tr>
</tbody>
</table>

(Continued on next page)
### No. 8

<table>
<thead>
<tr>
<th><strong>Limitation</strong></th>
<th>Applying RZ/T2 FSP v.1.2.0 pack to a project that is already working with RZ/T2M FSP v.1.1.0 causes an error when connecting the debugger.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Target</strong></td>
<td>RZ/T2M</td>
</tr>
<tr>
<td><strong>Category</strong></td>
<td>IAR EWARM</td>
</tr>
</tbody>
</table>
| **Description**| An error occurs when connecting to the debugger because the function name of vector table was changed in RZ/T2 FSP v.1.2.0. Change the following command in the “command line options (one per line)” to  
  • (Before change)  `--drv_vector_table_base=vector_table`  
  • (After change)  `--drv_vector_table_base=__Vector` |

![Image of command line options](image.png)
Appendix. How to Debug FSP Project with Flash Boot Mode

When debugging FSP project with flash boot mode (xSPI0 boot, NOR flash boot), the program cannot be stopped at the beginning of the user program (loader program). Another note on the use of flash debug boot mode is also included in this section.

Please note the following point depending on your IDE (e² studio or IAR EWARM) to debug the user program from its beginning.

1. **(Both e² studio and IAR EWARM)** Insert the loop part in startup.c.

   When debugging is started, the debugger stops the user program (loader program) about 100ms after the device boot process (boot code). If using e² studio 2022-10 or later, the PC (program counter) is replaced at the entry point (first line in `system_init()` function) after the debugger stops, otherwise, the PC points the address of somewhere in the user program.

   When debugging the program immediately after the boot process (boot code), insert the loop part in:

   - `/rzt/fsp/src/bsp/cmsis/Device/RENESAS/Source/startup.c`
   - `/rzn/fsp/src/bsp/cmsis/Device/RENESAS/Source/startup.c`

   The detailed position, at which the loop part should be inserted, depends on the IDE (Debugger) and Boot mode.

### IDE | Boot Mode | Position at which the loop part should be inserted.
---|---|---
| e² studio 2022-04 2022-07 | xSPI0 boot | Line after `static_constructor_init` in `mpu_cache_init()` function.

   ```
   #if BSP_CFG_C_RUNTIME_INIT
   /* Initialize static constructors */
   _asm volatile (  
     "static_constructor_init:  
       blx r0  
     "
   );
   #endif

   #if 1 // Software loops are only needed when debugging.
   _asm volatile (  
     "mov r0, #0  
     "movw r1, #0xf07f  
     "movt r1, #0x2fa  
     "software_loop:  
       adds r0, #1  
       cmp r0, r1  
       bne software_loop
     
     :: "memory";
   #endif
   ```

   **Note:**
   - For e² studio 2022-07, the position of the loop part is after `static_constructor_init` in `mpu_cache_init()` function.
   - For e² studio 2022-10 or later, the position of the loop part is before the entry point (`system_init()` function in IAR EWARM).

| e² studio 2022-10 or later IAR EWARM | NOR flash boot | First line in `system_init()` function.

   ```
   BSP_TARGET_ARM BSP_ATTRIBUTE_STACKLESS void system_init (void) {
     #if 1 // Software loops are only needed when debugging.
     _asm volatile (  
       "mov r0, #0  
       "movw r1, #0xf07f  
       "movt r1, #0x2fa  
       "software_loop:  
         adds r0, #1  
         cmp r0, r1  
         bne software_loop  
         
       :: "memory";
     #endif
     
     _asm volatile (  
       "set_hactlr:  
        MOV r0, [bsp_hactlr_bit_l]  
        MOV r0, 0  
        MCR p15, #4, r0, c1, c0, #1  
        " /* Write r0 to HACTLR */
     :: [bsp_hactlr_bit_l] "1" (BSP_HACTLR_BIT_L) : "memory";
   ```
Appendix. How to Erase Flash Memory

If you run a RAM execution without flash memory project with a program written in flash memory, it may be impossible to debug the project. Please erase flash memory by following steps depending on your IDE (e² studio or IAR EWARM) before running the project.

1. e² studio
   If you would like to erase the flash memory on RSK using J-Link Commander, execute the following steps.
   i) Set the switch for boot mode on RSK to correspond to the area to be erased.
   ii) Open the J-Link Commander.

   iii) First, type “connect” to establish a target connection and press enter. Next, specify the connection conditions as follows.
       - Device> (Device type name)

   Table 8 Device type name on Renesas Starter Kit+

<table>
<thead>
<tr>
<th>RSK</th>
<th>Device type name</th>
</tr>
</thead>
<tbody>
<tr>
<td>RSK + RZ/T2M</td>
<td>R9A07G075M24_CPU0</td>
</tr>
<tr>
<td>RSK + RZ/T2L</td>
<td>R9A07G074M04</td>
</tr>
<tr>
<td>RSK + RZ/N2L</td>
<td>R9A07G084M04</td>
</tr>
</tbody>
</table>

   - TIF>S
   - Speed> (Default: press enter without inputting any data)

(Continued on next page)
After that, confirm the message “Cortex-R52 identified.” Is displayed.

iv) Use the commands below to enable flash erase and erase the flash memory.

- `J-Link>exec EnableEraseAllFlashBanks`
- `J-Link>erase (Start address), (End address)`

(Continued on next page)
Table 9 External address space to be used in each boot mode

<table>
<thead>
<tr>
<th>RSK</th>
<th>Boot mode</th>
<th>External address space to be used</th>
<th>Start address</th>
<th>End address</th>
</tr>
</thead>
<tbody>
<tr>
<td>RSK + RZ/T2M</td>
<td>xSPI0 x1</td>
<td>xSPI0 CS0</td>
<td>0x60000000</td>
<td>0x63FFFFFF</td>
</tr>
<tr>
<td></td>
<td>16-bit bus</td>
<td>CS0</td>
<td>0x70000000</td>
<td>0x71FFFFFF</td>
</tr>
<tr>
<td>RSK + RZ/T2L</td>
<td>xSPI0 x1</td>
<td>xSPI0 CS0</td>
<td>0x60000000</td>
<td>0x63FFFFFF</td>
</tr>
<tr>
<td></td>
<td>xSPI1 x1</td>
<td>xSPI1 CS0</td>
<td>0x68000000</td>
<td>0x68FFFFFF</td>
</tr>
<tr>
<td>RSK + RZ/N2L</td>
<td>xSPI0 x1</td>
<td>xSPI0 CS0</td>
<td>0x60000000</td>
<td>0x63FFFFFF</td>
</tr>
<tr>
<td></td>
<td>16-bit bus</td>
<td>CS0</td>
<td>0x70000000</td>
<td>0x71FFFFFF</td>
</tr>
</tbody>
</table>

Figure 74: Specify erase range

After that, confirm the message “Erasing done.” Is displayed.

Figure 75: Message of flash memory erase complete

v) Enter “q” to exit J-Link Commander.

(Continued on next page)
2. IAR EWARM

If you want to erase the flash memory on RSK using IAR EWARM, execute the following steps.

i) Set the switch for boot mode on RSK to correspond to the area to be erased.

ii) Open the workspace of a project.

xxx.eww

![Figure 76: Open workspace for IAR EWARM](image)

iii) Select “Project” -> “Download” -> “Erase memory”.

![Figure 77: Select erase memory command](image)

(Continued on next page)
iv) Select erase memory space.

Figure 78: Select erase memory space

v) After the following dialog appears, erasing of the flash is complete if no error occurs.

Figure 79: Screen during erasing

Figure 80: Message of flash memory erase complete
Appendix. How to Change Boot Mode of FSP Project

When the boot mode of the project is changed, the Pin Configuration needs to be recreated. It also needs to rename and save the pin configuration to retain the original one before changing the boot mode. For example, one of specific cases in which re-configure is necessary is when a RAM execution without flash memory project is changed to flash boot mode (xSPI0 x1 boot mode and others). Please change the boot mode by following steps.

1. If the FSP version of your project is earlier than FSP v1.3.0, change it to FSP v1.3.0 or later.
2. Rename and save the current Pin Configuration in the Pins tab.
   ➢ How to rename Pin Configuration: Click "Manage Configurations..."

![Figure 81: How to rename Pin Configuration](image-url)

(Continued on next page)
2. Change the boot mode in the **BSP** tab. (The board must be the same as before the change.)

![Figure 82: Change the boot mode in the BSP tab](image)

3. Uncheck “Generate data” in the **Pins** tab.

![Figure 83: Uncheck Generate data in the Pins tab](image)

(Continued on next page)
4. Select the regenerated configuration for the board.

![Figure 84: Select the regenerated configuration for the board](image)

5. Check "Generate data" again and enter "g_bsp_pin_cfg" as the name.

![Figure 85: Check Generate data again](image)
## Revision History

<table>
<thead>
<tr>
<th>Rev.</th>
<th>Date</th>
<th>Description</th>
<th>Page</th>
<th>Summary</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.00</td>
<td>Jun.7.22</td>
<td>-</td>
<td>-</td>
<td>First Edition issued</td>
</tr>
<tr>
<td>1.01</td>
<td>Aug.9.22</td>
<td>-</td>
<td>-</td>
<td>Added the RZ/N2L device as target device.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>All</td>
<td>-</td>
<td>Unified some terminologies.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>p.9</td>
<td></td>
<td>Updated “SEGGER J-Link” section.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>- Added the software environment on which FSP projects are verified.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>p.13</td>
<td></td>
<td>Added the “RSK+RZN2L Board Setup” section.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>p.19</td>
<td></td>
<td>Updated “e2 studio Prerequisites”</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>- Updated the Windows PC requirements.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>p.33</td>
<td></td>
<td>Update “Prerequisites” section</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>- Added the note regarding the patch for debugging RZ/N2L</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>FSP project on EWARM.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>p.34</td>
<td></td>
<td>Updated “Create a New Project” section</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>- Added installation path of FSP SC.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>- Added some steps for creating an EWARM project.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>- Added Note subsection for debugging RZ/N2L EWARM project.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>p.53</td>
<td></td>
<td>Updated “Selecting a Board and Toolchain” section.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>- Added the detailed explanation how to select Board and Device</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>for creating a FSP project.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>p.68</td>
<td></td>
<td>Updated “Appendix. Known Issues” chapter</td>
</tr>
<tr>
<td></td>
<td></td>
<td>p.76</td>
<td></td>
<td>Updated “Appendix. Tool Software Limitations” chapter</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>-</td>
<td>Removed contents for RZ/T2M FSP v1.0.0</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>-</td>
<td>Added “Appendix. How to update J-Link DLL files in e2 studio”</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>-</td>
<td>chapter.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>-</td>
<td>Added “Appendix. How to Debug FSP Project with Flash Boot Mode”</td>
</tr>
<tr>
<td></td>
<td></td>
<td>p.80</td>
<td></td>
<td>Updated documentation for RZ/T2M FSP v1.1.0.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>- Removed contents for RZ/T2M FSP v1.0.0</td>
</tr>
<tr>
<td></td>
<td></td>
<td>All</td>
<td>-</td>
<td>Updated minor issues.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>- Fixed minor typo.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>- Adjusted page breaks.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>p.9</td>
<td></td>
<td>Updated “2.3.1 SEGGER J-Link” section</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>- Updated the FSP version and J-Link version for RZ/T2M</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>- Added the notification that J-Link OB S124 requires the</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>firmware update to debug RZ/T2M FSP project.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>- Added the link to Renesas Knowledge Base which explains how to</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>update J-Link DLL in e2 studio.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>p.45</td>
<td></td>
<td>Added “5.3.2.2 NOTE: Configure IAR EWARM Project</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>[RZ/T2M, RZ/T2L]” section.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>p.68</td>
<td></td>
<td>Updated “Appendix. Known Issues” chapter</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>- Remove some limitations regarding RZ/T2M</td>
</tr>
<tr>
<td>Rev.</td>
<td>Date</td>
<td>Description</td>
<td></td>
<td></td>
</tr>
<tr>
<td>-------</td>
<td>-----------</td>
<td>-------------------------------------------------------------------------------</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Page</strong></td>
<td><strong>Summary</strong></td>
<td></td>
</tr>
<tr>
<td>p.76</td>
<td></td>
<td></td>
<td>Updated the “Appendix. Tool Software Limitations” chapter.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• Added new limitation of e² studio regarding J-Link OB S124 firmware version.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• Added the link to explain how to update J-Link DLL.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1.03</td>
<td>Dec.23.22</td>
<td>-</td>
<td>Updated documentation for RZ/N2L FSP v1.1.0.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• Removed contents for RZ/N2L FSP v1.0.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>All</td>
<td>Updated minor issues.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• Fixed minor typo.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>p.69</td>
<td>Updated “Appendix. Known Issues” chapter.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• Removed some limitations regarding RZ/N2L</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>p.73</td>
<td>Updated the “Appendix. Tool Software Limitations” chapter.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• Removed some limitations regarding RZ/N2L</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>p.75</td>
<td>Updated “Appendix. How to Debug FSP Project with Flash Boot Mode” chapter.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• Added new procedure for RZ/N2L FSP v1.1.0.</td>
<td></td>
</tr>
<tr>
<td>1.04</td>
<td>Mar.23.23</td>
<td>All</td>
<td>Updated documentation for RZ/T2 FSP v1.2.0.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• Removed contents for RZ/T2M FSP v1.1.0.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• Added contents for RZ/T2L.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>p.1</td>
<td>Added video contents website link.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>p.9</td>
<td>Updated “2.3.1 SEGGER J-Link” section.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• Updated the FSP version and J-Link version for RZ/T2M and RZ/T2L.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• Removed the notification that J-Link OB S124 requires the firmware update to debug RZ/T2M FSP project.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>p.10-12</td>
<td>Updated “2.4 RSK+RZT2M Board Setup” section.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• Added explanation that other boot mode board settings refer to the RSK User’s Manual.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• Modified figure names and added a table title.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>p.13-15</td>
<td>Added “2.5 RSK+RZT2L Board Setup” section</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>p.16-18</td>
<td>Updated “2.6 RSK+RZN2L Board Setup” section</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• Corrected board name.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• Added explanation that other boot mode board settings refer to the RSK User’s Manual.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• Modified figure names and added a table title.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>p.23</td>
<td>Updated “4.3 Create a New Project for Blinky” section.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• Added RSK+RZT2L Board Setting.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>p.26</td>
<td>Updated “4.3.5 Where is main()?” section.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• Corrected product group name.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>p.32</td>
<td>Updated “4.5.4 Change CPSR Register Value” section.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• Revised description.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• Added description of how to automatically change CPSR register value.</td>
<td></td>
</tr>
</tbody>
</table>
### Description

<table>
<thead>
<tr>
<th>Rev.</th>
<th>Date</th>
<th>Page</th>
<th>Summary</th>
</tr>
</thead>
</table>
|      |        | p.33 | Updated “4.6 Run the Blinky Project” section.  
|      |        |      | • Removed LEDs working in CPU1 project. |
|      |        | p.34 | Updated “5.3.1 Prerequisites” section.  
|      |        |      | • Added note for RZ/T2L patch file. |
|      |        | p.37 | Updated “5.3.2 Create a New Project” section.  
|      |        |      | • Added RSK+RZT2L Board Setting. |
|      |        | p.50 | Updated “5.3.4 Download & Debug the Project” section.  
|      |        |      | • Removed LEDs working in CPU1 project. |
|      |        | p.69 | Updated “6.5 Adding and Configuring HAL Drivers” section.  
|      |        |      | • Added a table title. |
|      |        | p.71-73 | Updated “Appendix. Known Issues” section.  
|      |        |      | • Added a table “List of Known Issues” |
|      |        |      | • Numbered each issue. |
|      |        |      | • Removed issue of adding "r_dsmif" alone |
|      |        |      | • Updated issue contents that the BSP properties are sometimes configured to incorrect configuration |
|      |        |      | • Removed Ethernet SELECTOR issue. |
|      |        | p.74-77 | Updated “Appendix. Tool Software Limitations” section.  
|      |        |      | • Added a table “List of Tool Software Limitations” |
|      |        |      | • Numbered each limitation. |
|      |        |      | • Added new limitation of applying RZ/T2 FSP v.1.2.0 pack. |
| 1.05 | Jun.30.23 | All | Updated documentation for RZ/N2L FSP v1.2.0.  
|      |        |      | • Removed contents for RZ/N2L FSP v1.1.0 |
|      |        | p.9 | Updated “2.3.1 SEGGER J-Link” section.  
|      |        |      | • Updated the FSP version and e² studio version for RZ/N2L. |
|      |        | p.30 | Updated “4.5.2 Debug Steps” section.  
|      |        |      | • Added description of how to automatically change CPSR register value for RZ/N2L and e² studio 2023-04. |
|      |        | p.33 | Updated “4.5.4 NOTE: Change CPSR Register Value [RZ/T2M, RZ/T2L]” section.  
|      |        |      | • Changed section title to limit the target device |
|      |        | p.35 | Updated “5.3.1 Prerequisites” section.  
<p>|      |        |      | • Removed EWARM Patch for RZ/N2L |</p>
<table>
<thead>
<tr>
<th>Rev.</th>
<th>Date</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td><strong>Page</strong></td>
</tr>
<tr>
<td></td>
<td></td>
<td>p.72-77</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>p.78</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>p.82</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1.06</td>
<td>Sep.8.23</td>
<td>All</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>p.6</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>p.26</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>p.28</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>p.43</td>
</tr>
<tr>
<td></td>
<td></td>
<td>p.44</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>p.68-73</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>p.75</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>p.80</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>p.82-86</td>
</tr>
<tr>
<td>1.07</td>
<td>Sep.29.23</td>
<td>All</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Rev.</td>
<td>Date</td>
<td>Page</td>
</tr>
<tr>
<td>------</td>
<td>--------</td>
<td>------</td>
</tr>
<tr>
<td></td>
<td></td>
<td>p.9</td>
</tr>
<tr>
<td></td>
<td></td>
<td>p.80</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>p.68-75</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>p.76-80</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>p.87-89</td>
</tr>
</tbody>
</table>
General Precautions in the Handling of Microprocessing Unit and Microcontroller Unit Products

The following usage notes are applicable to all Microprocessing unit and Microcontroller unit products from Renesas. For detailed usage notes on the products covered by this document, refer to the relevant sections of the document as well as any technical updates that have been issued for the products.

1. Precaution against Electrostatic Discharge (ESD)
   A strong electrical field, when exposed to a CMOS device, can cause destruction of the gate oxide and ultimately degrade the device operation. Steps must be taken to stop the generation of static electricity as much as possible, and quickly dissipate it when it occurs. Environmental control must be adequate. When it is dry, a humidifier should be used. This is recommended to avoid using insulators that can easily build up static electricity.
   Semiconductor devices must be stored and transported in an anti-static container, static shielding bag or conductive material. All test and measurement tools including work benches and floors must be grounded. The operator must also be grounded using a wrist strap. Semiconductor devices must not be touched with bare hands. Similar precautions must be taken for printed circuit boards with mounted semiconductor devices.

2. Processing at power-on
   The state of the product is undefined at the time when power is supplied. The states of internal circuits in the LSI are indeterminate and the states of register settings and pins are undefined at the time when power is supplied. In a finished product where the reset signal is applied to the external reset pin, the states of pins are not guaranteed from the time when power is supplied until the reset process is completed. In a similar way, the states of pins in a product that is reset by an on-chip power-on reset function are not guaranteed from the time when power is supplied until the power reaches the level at which resetting is specified.

3. Input of signal during power-off state
   Do not input signals or an I/O pull-up power supply while the device is powered off. The current injection that results from input of such a signal or I/O pull-up power supply may cause malfunction and the abnormal current that passes in the device at this time may cause degradation of internal elements. Follow the guideline for input signal during power-off state as described in your product documentation.

4. Handling of unused pins
   Handle unused pins in accordance with the directions given under handling of unused pins in the manual. The input pins of CMOS products are generally in the high-impedance state. In operation with an unused pin in the open-circuit state, extra electromagnetic noise is induced in the vicinity of the LSI, an associated shoot-through current flows internally, and malfunctions occur due to the false recognition of the pin state as an input signal become possible.

5. Clock signals
   After applying a reset, only release the reset line after the operating clock signal becomes stable. When switching the clock signal during program execution, wait until the target clock signal is stabilized. When the clock signal is generated with an external resonator or from an external oscillator during a reset, ensure that the reset line is only released after full stabilization of the clock signal. Additionally, when switching to a clock signal produced with an external resonator or by an external oscillator while program execution is in progress, wait until the target clock signal is stable.

6. Voltage application waveform at input pin
   Waveform distortion due to input noise or a reflected wave may cause malfunction. If the input of the CMOS device stays in the area between $V_{IL}$ (Max.) and $V_{IH}$ (Min.) due to noise, for example, the device may malfunction. Take care to prevent chattering noise from entering the device when the input level is fixed, and also in the transition period when the input level passes through the area between $V_{IL}$ (Max.) and $V_{IH}$ (Min.).

7. Prohibition of access to reserved addresses
   Access to reserved addresses is prohibited. The reserved addresses are provided for possible future expansion of functions. Do not access these addresses as the correct operation of the LSI is not guaranteed.

8. Differences between products
   Before changing from one product to another, for example to a product with a different part number, confirm that the change will not lead to problems. The characteristics of a microprocessing unit or microcontroller unit products in the same group but having a different part number might differ in terms of internal memory capacity, layout pattern, and other factors, which can affect the ranges of electrical characteristics, such as characteristic values, operating margins, immunity to noise, and amount of radiated noise. When changing to a product with a different part number, implement a system-evaluation test for the given product.
Notice

1. Descriptions of circuits, software and other related information in this document are provided only to illustrate the operation of semiconductor products and application examples. You are fully responsible for the incorporation or any other use of the circuits, software, and information in the design of your product or system. Renesas Electronics disclaims any and all liability for any losses and damages incurred by you or third parties arising from the use of these circuits, software, or information.

2. Renesas Electronics hereby expressly disclaims any warranties against and liability for infringement or any other claims involving patents, copyrights, or other intellectual property rights of third parties, by or arising from the use of Renesas Electronics products or technical information described in this document, including but not limited to, the product data, drawings, charts, programs, algorithms, and application examples.

3. You are licensed, express, implied or otherwise, is granted hereby under any patents, copyrights or other intellectual property rights of Renesas Electronics or others.

4. You shall be responsible for determining what licenses are required from any third parties, and obtaining such licenses for the lawful import, export, manufacture, sales, utilization, distribution or other disposal of any products incorporating Renesas Electronics products, if required.

5. You shall not alter, modify, copy, or reverse engineer any Renesas Electronics product, whether in whole or in part. Renesas Electronics disclaims any and all liability for any losses or damages incurred by you or third parties arising from such alter, modification, copying or reverse engineering.

6. Renesas Electronics products are classified according to the following two quality grades: “Standard” and “High Quality”. The intended applications for each Renesas Electronics product depends on the product’s quality grade, as indicated below.

   - “Standard”: Computers; office equipment; communications equipment; test and measurement equipment; audio and visual equipment; home electronic appliances; machine tools; personal electronic equipment; industrial robots; etc.
   - “High Quality”: Transportation equipment (automobiles, trains, ships, etc.); traffic control (traffic lights); large-scale communication equipment; key financial terminal systems; safety control equipment; etc.

7. Unless expressly designated as a high reliability product or a product for harsh environments in a Renesas Electronics data sheet or other Renesas Electronics document, Renesas Electronics products are not intended or authorized for use in products or systems that may pose a direct threat to human life or bodily injury (artificial life support devices or systems; surgical implantations; etc.), or may cause serious property damage (space systems; underwater repeaters; nuclear power control systems; aircraft control systems; key plant systems; military equipment; etc.). Renesas Electronics disclaims any and all liability for any damages or losses incurred by you or any third parties arising from the use of any Renesas Electronics product that is inconsistent with any Renesas Electronics data sheet, user’s manual or other Renesas Electronics document.

8. No semiconductor product is absolutely secure. Notwithstanding any security measures or features that may be implemented in Renesas Electronics hardware or software products, Renesas Electronics shall have absolutely no liability arising out of any vulnerability or security breach, including but not limited to, unauthorized access to or use of a Renesas Electronics product or a system that uses a Renesas Electronics product. RENESAS ELECTRONICS DOES NOT WARRANT OR GUARANTEE THAT RENESAS ELECTRONICS PRODUCTS, OR ANY SYSTEMS CREATED USING RENESAS ELECTRONICS PRODUCTS WILL BE INVULNERABLE OR FREE FROM CORRUPTION, ATTACK, VIRUSES, INTERFERENCE, HACKING, DATA LOSS OR THEFT, OR OTHER SECURITY INTRUSION (“Vulnerability Issues”). RENESAS ELECTRONICS DISCLAIMS ANY AND ALL RESPONSIBILITY OR LIABILITY ARISING FROM OR RELATED TO ANY VULNERABILITY ISSUES. FURTHERMORE, TO THE EXTENT PERMITTED BY APPLICABLE LAW, RENESAS ELECTRONICS DISCLAIMS ANY AND ALL WARRANTIES, EXPRESS OR IMPLIED, WITH RESPECT TO THIS DOCUMENT AND ANY RELATED OR ACCOMPANYING SOFTWARE OR HARDWARE, INCLUDING BUT NOT LIMITED TO THE IMPLIED WARRANTIES OF MERCHANTABILITY, OR FITNESS FOR A PARTICULAR PURPOSE.

9. Although Renesas Electronics endeavors to improve the quality and reliability of Renesas Electronics products, semiconductor products have specific characteristics, such as the occurrence of failure at a certain rate and malfunctions under certain use conditions. Unless designated as a high reliability product or a product for harsh environments in a Renesas Electronics data sheet or other Renesas Electronics document, Renesas Electronics products are not subject to radiation resistance design. You are responsible for implementing safety measures to guard against the possibility of bodily injury, injury or damage caused by fire, and/or danger to the public in the event of a failure or malfunction of Renesas Electronics products, such as safety design for hardware and software, including but not limited to redundancy, fire control and malfunction prevention, appropriate treatment for aging degradation or any other appropriate measures. Because the evaluation of microcomputer software alone is very difficult and impractical, you are responsible for evaluating the safety of the final products or systems manufactured by you.

10. Please contact a Renesas Electronics sales office for details as to environmental matters such as the environmental compatibility of each Renesas Electronics product. You are responsible for carefully and sufficiently investigating applicable laws and regulations that regulate the inclusion or use of controlled substances, including without limitation, the EU RoHS Directive, and using Renesas Electronics products in compliance with all applicable laws and regulations. Renesas Electronics disclaims any and all liability for damages or losses occurring as a result of your noncompliance with applicable laws and regulations.

11. Renesas Electronics products and technologies shall not be used for or incorporated into any products or systems whose manufacture, use, or sale is prohibited under any applicable domestic or foreign laws or regulations. You shall comply with any applicable export control laws and regulations promulgated and administered by the governments of any countries asserting jurisdiction over the parties or transactions.

12. It is the responsibility of the buyer or distributor of Renesas Electronics products, or any other party who distributes, disposes of, or otherwise sells or transfers the product to a third party, to notify such third party in advance of the contents and conditions set forth in this document.

13. This document shall not be reproduced, reprinted or duplicated in any form, in whole or in part, without prior written consent of Renesas Electronics.

14. Please contact a Renesas Electronics sales office if you have any questions regarding the information contained in this document or Renesas Electronics products.

(Note1) “Renesas Electronics” as used in this document means Renesas Electronics Corporation and also includes its directly or indirectly controlled subsidiaries.

(Note2) “Renesas Electronics product(s)” means any product developed or manufactured by or for Renesas Electronics.

(Renewed October 2020)

Corporate Headquarters

TOYOSU FORESIA, 3-2-24 Toyosu,
Koto-ku, Tokyo 135-0061, Japan

www.renesas.com

Contact information

For further information on a product, technology, the most up-to-date version of a document, or your nearest sales office, please visit:
www.renesas.com/contact

Trademarks

Renesas and the Renesas logo are trademarks of Renesas Electronics Corporation. All trademarks and registered trademarks are the property of their respective owners.

© 2024 Renesas Electronics Corporation. All rights reserved.